
Game menu commands

The Game menu offers the following commands:

Change 
Player...

Allows you to choose a new player and starts a new game.

New Creates a new game.
Load Loads a saved game.
Save Saves a game.
Statistics Shows win/loss statistics.
Undo Undoes the last move.
Exit Exits the game.



Settings menu commands

The Settings menu offers the following commands:

Modem Allows you to change your modem settings including speed and port.
Board Allows you to change the appearance of the checkers board.
Pieces Allows you to change the appearance of the checkers pieces.
Sound Allows you to turn the game sounds on or off.
Music Allows you to change the background music.



View menu commands

The View menu offers the following commands:

Toolbar Shows or hides the toolbar.
Status Bar Shows or hides the status bar.
Chat Show or hides the char window. The char window allows 

you to send messages to your network opponents.

Help menu commands

The Help menu offers the following commands, which provide you assistance with this 
application: 

Help 
Topics

Offers you an index to topics on which you can get help.

About Displays the version number of this application.



New command (Game menu)

Use this command to start a new game.

Shortcuts

Toolbar:
Keys: F2



Change Player command (Game menu)

Use this command to change players.

MVP Checkers keeps track of how well each player does compared to other players (see 
Statistics for more information).

Name
Choose the name you’d like to be known as.    You can type in new names or press the arrow 
at the right to select names that have already been entered.

Always sign on as this player
If you always want to sign in as the same player, select this to prevent this dialog.

Appearance
Use the scroll bar below the face to choose your appearance.

Color Preference
Choose what color you’d prefer to play.    If you and your opponent both prefer to play the 
same color, random colors will be assigned.

Remove Player
Press this button to remove this player.    All statistics about this player will be removed.



Exit command (Game menu)

Use this command to end your game.    You can also use the Close command on the 
application Control menu.    You are prompted to save games with unsaved changes.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the 
most common commands, such as File Open.    A check mark appears next to the menu item 
when the Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    The 
toolbar provides quick mouse access to many tools,

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Click To

Open a new game.

Undoes the last move.

Changes settings for this and future games.

Displays win/loss statistics.

Displays the version number of this application.

Displays help for clicked on buttons, menus and windows.



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be 
executed by the selected menu item or depressed toolbar button, and keyboard latch state. 
A check mark appears next to the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the window.    To display or hide the status bar, 
use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to 
navigate through menus.    This area similarly shows messages that describe the actions of 
toolbar buttons as you depress them, before releasing them.    If after viewing the description
of the toolbar button command you wish not to execute the command, then release the 
mouse button while the pointer is off the toolbar button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.
NUM The Num Lock key is latched down.
SCRL The Scroll Lock key is latched down.



Index command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can
jump to step-by-step instructions for using the game and various types of reference 
information.    

Once you open Help, you can click the Contents button whenever you want to return to the 
opening screen.



Using Help command (Help menu)

Use this command for instructions about using Help.



About command (Help menu)

Use this command to display the copyright notice and version number of the game.



Context Help command 

Use the Context Help command to obtain help on some portion of the game.    When you 
choose the Toolbar's Context Help button, the mouse pointer will change to an arrow and 
question mark.    Then click somewhere in the window, such as another Toolbar button.    The 
Help topic will be shown for the item you clicked.

Shortcut
Keys: SHIFT+F1



Title Bar

<< Show your application's title bar here. >>

The title bar is located along the top of a window.    It contains the name of the application 
and game.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging 
their title bars.

A title bar contains the following elements:
Application Control-menu button
Maximize button
Minimize button
Name of the application
Name of the game
Restore button



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the
arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer 

to the border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or 
dialog box with the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the game window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a game window.



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.



Undo command (Game menu)

Use this command to undo the last move.

Shortcuts

Toolbar:
Keys: CTRL+Z



Statistics command (Game menu)

Use this command to show win/loss statistics.    The Statistics dialog box is diaplayed.

Shortcuts

Toolbar:
Keys: F4



Chat command (View menu)

Use this command to display the Chat window. The Chat window allowsyou to send 
messages to your network opponents. The Chat window is only available in network games.

Shortcuts
Keys: F8



Chat window

The Chat window allows you to send message to your network opponents. The Chat window 
is only available in network games.

Type your message in the To Opponent field, then press the Send button.    Your message 
will be sent to your opponent.

Tip
Press F8, or select Chat in the View menu, to hide or show the Chat window.



Game Over dialog

The Game Over dialog tells you the results of the game, allows you to change the skill level 
of your computer opponent, and offers to play another game. 



Statistics dialog box

The table shows win/loss statistics the game, sorted by overall performance.

The Overall column displays the player’s percentage and their number of wins, losses and 
ties versus all types of opponents.

The vs. Human column displays the player’s statistics versus all human opponents.

The vs. Beginner Computer, vs. Intermediate Computer, and vs. Expert Computer 
displays the player’s statistics versus beginner, intermediate and expert computer 
opponents.

Close
Closes the Statistics dialog box.

Clear
Deletes statistics for the selected player.

Help
Displays this help screen.



Choose Opponent dialog

The Choose Opponent dialog is the quickest way to start a new game. It is intended for 
experts only. If you’re having trouble with this complex dialog, select Walk Me Thru to try 
the New Game Wizard.

Opponent Type
Walk Me 
Thru

Select to start the New Game Wizard, a simplified way to start a new 
game. It’s especially good at helping out setting up Network or 
Internet games.

Human Select to play against a friend on this machine.
Computer Select to play against a computer opponent.
Network Select to play over a Modem, a Network, or the Internet.

Human Opponents
Select the player, or type in a new name to create a new player. The player’s appearance 
can be changed by clicking on the arrows below the face.

This area is only available when Human is selected in the Opponent Type area.

Computer Opponents
Select the player you would like to play against. The Beginner players are at the far left, the 
Intermediate in the middle, and the Expert players at the far right.

This area is only available when Computer is selected in the Opponent Type area.

Network Type
Select the type of network you would like to use.

A modem comes with most computers sold today. It allows two computers to “talk” over 
telephone lines.

A Local Area Network is a connection between two or more computers. Special hardware is 
required.

Internet allows you to play against anyone in the world. To use this option, you must already 
be connected to the Internet.

This area is only available when Network is selected in the Opponent Type area.

Call Or Answer
Select whether you want your computer to call or answer. Network connections are very 
similar to telephone calls in that one person must call, and the other must answer. There is, 
however, one important difference: when making a network connection, the person 
answering must tell his computer to answer before taking any calls.

This area is only available when Network is selected in the Opponent Type area.

Who To Call
Select who you would like to call.    For Local Area Networks, the list is filled in with the 



names of players who are Answering.    For other network types, press the New button to 
enter information about who you would like to call.



Modem Settings

The Modem Settings dialog allows you to change the settings for your modem.

Port
Use this setting to tell MVP Checkers what port your modem is connected to.    See your 
computer’s documentation if you’re unsure of what to set this to.

Baud Rate
Use this setting to tell MVP Checkers what speed your modem is capable of.    Most modems 
today are capable of connecting at greater than 14400.    Checkers does not send a great 
deal of information over the modem, so don’t be too concerned with setting this as high as 
you can.

Advanced
Allows you to set advanced information about your modem, such as special dialing or 
response strings.    Please don’t play with these settings unless you know what you’re doing.



New Game Wizard

The New Game Wizard walks you through setting up a game, including setting up network 
games.

The first step in setting up a game is to choose your Opponent Type.    Your choices are:
Human Play against a friend (or enemy).
Computer Play against a computer opponent.
Network Play against someone over your Modem, Local Area Network,

or the Internet.
Same as last time Play a game just like you did last time.
Use Expert Mode If you’ve had enough of this hand-holding, you can use 

Expert Mode to start games more quickly.

New Game Wizard - Human

Name
Choose a name for who you want to play against.    You can select an existing player by 
pressing on the arrow to the right.

Appearance
Choose an appearance for the player.

Press Next when you’re ready to go on.



New Game Wizard - Summary

This screen shows the choices you’ve made so far.    If you want to change your mind, press 
Back.    If you’re ready to play, press Finish.



New Game Wizard - Computer

Choose the computer player you’d like to play against by clicking on them.    The players on 
the left are beginner players.    The players in the middle are intermediate, and the players 
on the right are advanced.

Press Next when you’re ready to go on.



New Game Wizard - Network

Select which type of network you want to use:
Modem Play across your telephone line using a modem.
Local Area 
Network

Play across your Local Area Network.    Your computer needs 
special hardware, called a Network Adapter, to use this network 
type.    More information

Internet or TCP/IP Play across the Internet.    You need to have an Internet 
connection up and running before using this network type.

Local Area Network

In order to use the Local Area Network setting, your computer must have a network adapter 
card.    Most home computers do not have such hardware.

Your network must be using a NetBIOS compatible protocol.    If you’re unsure, try playing.    If
Checkers complains that this is missing, install it using the following directions.    Make sure 
you have your Windows disks or CD handy, Windows will probably ask for them to get 
additional files not already installed on your computer.

1. Press the Start button in the lower left corner.
2. Select Settings.
3. Select Control Panel.
4. Double click on Network.
5. Press the Add button.
6. Select Protocol and press the Add button.
7. Select Microsoft in the Manufacturers box.
8. Select NetBEUI in the Network Protocols box.
9. Press OK.



New Game Wizard - Call or Answer

Press Call if you want to call your opponent, or press Answer if you want to wait for your 
opponent to call you.

Press Next when you’re ready to go on.



New Game Wizard - Who To Call

Select the person you want to call.    If the player doesn’t exist, press the New button to add 
the player to your list.

Press Next when you’re ready to go on.



New Opponent

Name
Enter the name of the player here.

Phone (only available for modem opponents)
Enter the phone number of the player you’re going to call.

Address (only available for Internet play)
Enter your opponent’s Internet Address.    Your opponent can give this to you by answering 
an Internet game.    Checkers will report his Internet Address to him.



Game Over

This dialog tells you the result of the game, and offers to play another game.

Press Yes is you’d like to play another game of the same type, or press No if you’ve been 
beaten into submission.



Choose Opponent Dialog

Use choose opponent dialog to tell MVP Checkers what type of opponent you’d like to play 
against.

Opponent Type
Walk Me Thru Choose this if you’d like some help or more information about the 

choices you’re making.
Human Play against a friend.
Computer Play against a computer opponent.
Network Play against someone over your Modem, Local Area Network, or the

Internet.

Once you choose an opponent type, you’ll be asked for more information about the game 
you want to play.    If you have any questions about these options, select Walk Me Thru and
press OK.



Connect Dialog

This dialog displays when you’re waiting to connect to a network opponent.    Press Cancel 
to stop trying to connect or wait until the connection is established.



Digital Storm has also created Vicious Circle, a multi-player personal combat simulator with 
economic and strategic planning.    Look for it at your local software retailer.
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How To Play Checkers

Objective:    Capture all your opponent’s pieces or block them so they are unable to move.

Rules:
Black always moves first.
Pieces move diagonally forward.    Black starts at the bottom of the board and moves 

up towards Red; Red starts at the top of the board and moves down towards Black.
Captures are compulsory.    If you can capture a piece, you must do so.    If you have 

more then one possible capture, you may choose which to make.
To capture an opponent he must be in one of the squares diagonally in front of you, 

and the square beyond him must be empty.    The captured pieces is removed from the 
game.    If the piece can make another capture in its new location, it must continue to jump 
until it either reaches the last row or has no more possible jumps.

When a piece reaches the last row, it is promoted to a King.    Kings can move and 
capture backward as well as forward

The game is over when a player can no longer make a move either because he has 
no more pieces, or his opponent has him totally blocked and he has no valid moves.

To Play:
Select the piece to move.
Select the square to move the piece to.
If the moved piece can continue jumping, it will remain selected.    Select the next 

square to move the piece to.




